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Mengenal Widget-widget
dasar dalam Flutter
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Widget

“ MOJADIPRO

Widget merupakan objek visual yang merepresentasikan sebuah bagian dari tampilan aplikasi.
Widget dapat berupa tombol, teks, gambar, kotak, atau apapun yang dapat dilihat pada layar.

Scaffold

AppBar

Text

onPanUpdate.
DragUpdateDetatis{Offset(0.3, 0.0))

RichText

Elutter World for Mobile

SafeArea

Container




Widget Tree [ Materies Ape ] 84l o roPr0

[m

appBar body
1 L Scaffold J l
AppBar Center ]
backgroundColor title l chitis
h 4
[ - ] [ e ] [ Image
Widget tree atau pohon widget sering digunakan untuk menggambarkan l'mag"

hierarki tampilan atau struktur antarmuka pengguna dalam suatu aplikasi. [ J
Assetimage
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Material App

“ MOJADIPRO

MaterialApp adalah kelas atau widget yang menjadi komponen utama atau inti dari aplikasi flutter.
Widget yang dapat diakses menggunakan kelas MaterialApp :

AppBar

A toolbar that might contain other
widgets such as @ TabBar anda
‘FlexibleSpaceBar .

Great horned owl

TOO UM, @1D3 ANowen
44 1P T

e Armvashin

ElevatedButton

A Material Design elevated button
A filled button whose material
elevates when pressed

Column

Layout a list of child widgets in the
vertical direction

FlutterLogo

The Flutter logo, in widget form.
This widget respects the
lconTheme

Container

A convenience widget that
CoOmMDINES COMMON painting,
positioning, and sizing widgets.

lcon

A Material Design icon.

Image Placeholder Row

Layout a list of child widgets in the
horizontal direction.

A widget that draws a box that
represents where other widgets
will one day be added.

A widget that displays an image.

Abc

Scaffold Text

Implements the basic Material A run of text with a single style
Design visual layout structure. This

ciass provides APls for showing

grawers, snack bars, and bottom

sheets.



“ MOJADIPRO

JiD N Scaffold

Sample Code

Di dalam MaterialApp terdapat scaffold class.
Scaffold adalah widget yang menyediakan
kerangka Kkerja dasar untuk membangun
antarmuka pengguna (Ul) aplikasi.

Widget Scaffold menawarkan struktur tata letak

yang umum digunakan dalam aplikasi, You have pressed the button 0 times.
termasuk App bar, body, drawer, floating action

button, dan bottom navigation bar.




one B Scaffold £Q o 0w

leading  tile  appBar actions

N

Di dalam Scaffold terdapat Appbar dan Body AppBar [FiSS
Appbar adalah bagian atas aplikasi yang flexiableSpace
biasanya berisi judul, ikon kembali, ikon bottom

aksi, dan opsi menu.

Body adalah konten utama aplikasi yang
ditampilkan di bawah App bar. Kita dapat
menempatkan berbagai widget di dalam
body untuk menampilkan informasi, formulir, vou have presse; (;:‘je putton O imes-
daftar, atau tampilan lainnya. Y
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“ MOJADIPRO

Berikut adalah beberapa widget dasar yang perlu diketahui

Digunakan untuk menampilkan
teks. Anda dapat mengatur
properti seperti style, font, dan
alignment.

Digunakan untuk menampilkan
gambar. Anda dapat
menentukan gambar dari file
lokal atau URL.

Suatu simbol atau gambar kecil
yang digunakan untuk mewakili
suatu objek, aksi, atau konsep
tertentu.

Digunakan untuk  membuat
tombol dengan efek tampilan
yang meningkat (elevated) atau
menonjol.



“ MOJADIPRO

DIJ; Penggunaan Custom Warna pada Material Design

tem — Material Design 3 -+ N - X
e G @ m3.material.io/styles/color/the-color-system/key-colors-tones Q 2 » O G
T &b Activity . Kampus M... 4 locathost / 127.0.0.... G Discord | Friends @ Cnline Courses - U l5] chatgpt

= < 7 -
M Gmail @B YouTube @ Maps B Transia

®

Home

Get started

<>

Develop

. Color system

o

Styles

®

Components

(]

Blog

Custom colors Accessibility

Key colors & tones Color roles Tokens

Buka material design di Google - styles > color &> color system
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Home

Get started

O

Develop

O

Foundations

@

Styles

®

Components

3]

Blog

Key colors & tones

Primary Key Color

The tonal value of each color is expressed with the number associated with that role, e.g. primary40 is the

Color roles

primary key color at a tone value of 40

Tokens

Custom colors

95

100

t‘ MOJADIPRO

Accessibility

On this page

Color
system

Key colors

/,,v’ ~
I,\ Tonal palettes
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@

Home

Get started

<>

Develop

O

Foundations

@

Styles

®

Components

]

Bleg

Key colors & tones

Yellow custom input

Orange custom input

Green custom input

Color roles Tokens

On Yellow

Yollowd(Q Yellow10C

On Orange

Oranged0 Orangel00

On Green

GreentOC

Custom colors

Yellow Container

Orange Container

Green Container

Yellow@0

Orange0

Green%0

on Orange Container

“ MOJADIPRO

Accessibility

On this page

Color
system

l' Adding custom
| colorsto ascheme

Examples of custom colors that can be added and translated into a group of four compatible tones that would be
used for role mapping in a custom light scheme



Contoh Kode Penggunaan Warna &€ o-norro

Pecel 4 AP 27 (mobile) /’ main.dart -
S README.md Fe main.dart Emulator: C

~S W D =12 = [
main() +H
runApp(

MaterialAppl(
homes: Scaffold(

backgroundColor green
- Bar: Appt %9 Colors.c i
<— = -
Colors.c Accent =
=2 Colors.lLightG 1|
- = -
\ Coltors.itight Accent =

Anda bisa menuliskan nama warna, atau dengan menambahkan angka. Contoh : Colors.green40
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Berikut ini adalah beberapa contoh kode penggunaan warna pada Flutter :

1. Menggunakan kode warna HEX :

Color myColor = Color(0xFFOOFFOO0); // Contoh warna hijau (OxFFOOFFOO)

2. Menggunakan kode warna RGB :

Color myColor = Color.fromRGBO(255, 0, 0, 1); // Contoh warna merah (RGB: 255, 0, 0)

3. Menggunakan nama warna primitif :

Color myColor = Colors.blue; // Contoh warna biru
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Berikut ini adalah beberapa contoh kode penggunaan warna pada Flutter :

4. Menggunakan Gradient (Gradien) :

Container(
decoration: BoxDecoration(
gradient: LinearGradient(
colors: [Colors.red, Colors.blue],
begin: Alignment.topCenter,
end: Alignment.bottomCenter,

5. Menggunakan Material Design Colors:

import 'package:flutter/material.dart’;

Color myColor = Colors.teal; // Contoh warna teal




9”9& Memasukkan Network Image &4 vosrorro

G flutter - Google Penelusuran X -+ v = C
< C 8 google.com/search?q=flutter&sxsrf=APWXEddZeWYKTSBMWyMI4EdLIDuaByUI7A:1684940417679&source=Inms&tbm=isch&sa=X&ved=2ahUKEwiexMCYnl7... |© W » = 0O
~ \ T 2 o - = A e 1 /909 A \ - SR o 49700 N . o 8 VA li Caureas - | = cha ¢
M Gmail @B YouTube @ Maps B Translate @ News £ Sprint1(2022-10-2.. & Activity KampusM.. & locathost / 127.0.0.... Q Discord | Friends @ Cnline Courses - U. (G chatgpt

% Flutter

A Fluiter 8 Crocodic

Flutter documentation | Flutter Mengenal Flutter pada Mobile Apps Develop.. F I l l t t e r

M Cowtgns = @) § i

n
.
o $
o
B - vues .
« s

|- .
B R L. [T W e T

Flutter documentation | Flutter

@ YouTube B cult by Honeypot Gambar bisa saja memiliki hak cipta. Pelajari Lebih Lanjut

Flutter - YouTube What is Flutter And Why It's used For Mobile App Dev..



T A\ Memasukkan Network Image & ~o-rorero

& flutter - Google Penelusuran = ¢ flutter-logo-sharing.png (937=40 X -+ e — >
_ ( & https://docs.flutter.dev/assets/images/flutter-logo-sharing.png Q. a8 = -gk) » = 0O o :
M Gmail B YouTube @ Maps B Translate @& Mews 2 Sprint 1(2022-10-2.. & Activity . Kampus M... & localhost / 127.00.... G Discord | Friends @ Crline Courses - U chatgpt »

¢ Flutter

Copy URL dan masukkan ke dalam kode
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Pixet 4 APl 27 (mobile) - ’; main.dart ¥ X - | A D. L0
=% README,md #t main.dart Emulator: [} Pixel 4 AP| 27 2 —
tAav WO D WD e B @D

EURUTORER U NN

main() 4 -//f
L | QO O HN b I REK
runApp | “
My Apps

MaterialApp( Z
home: Scaffold( =
backgroundColor: Colors [ ] 2
appBar: AppBar( ;
title: Text( . E
backgroundColor: Colors [ ] =

child: Image(

1BBDBUEN 201A3 () &)

€ Flutter

—~

l0ppadsu| dayngy N

1

l0jcx3 a1y adad )
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Mengclone Project Flutter
dari Github



‘ WD N Mengclone Project Flutter dari Github “ MOJADIPRO

() GitHub - londonappbrewery/mi X + W = ot
&« C & github.com/londonappbrewery/mi_card_flutter Z =2 w » = 0O 0 :
M Gmail @B YouTube @ Maps B Translate @ News 2 Sprint1(2022-10-2.. & Activity - Kampus M. Ak localhost / 127.0.0.... (a Discerd | Friends @ Cnline Courses - U f} chatgpt »

Q Product Solutions Open Source Pricing Sign up |

] |{}nd[}nappbrewer}wfmi_card_ﬂutter Public L\ Notifications % Fork 1k 17 Star 401 -

(> Code (%) lIssues 25 i1 Pullrequests 6 () Actions [ Projects (O Security |~ Insights

P master ~ F 1branch > 0tags Go to file m About

Starter code for the Mi Card Project from

% TheMuellenator updating gradle wrapper (115 o1f87e4 on Nov 18, 2021 YO 2 commits the Complete Flutter Development
Bootcamp
android updating gradle wrapper 2 years ago
& www.appbrewery.co
ios updating project for android 2 years ago
M0 Readme
lib updating project for android 2 years ago & 401 stars
[y README.md updating project for android 2 years ago & 31 watching
[Y pubspecyaml updating project for android 2 years ago ¥ 1lkforks

Report repository



tw

S\

O GitHub - londonappbrewery/mi_ X =+

< &

M Gmaill EB YouTube 0 Maps & Translate @ Mews 2 Sprint 1(2022-10-2.. &b Activity - Kampus M...

@ github.com/londonappbrewery/mi_card_flutter

O Product Solutions Open Source Pricing

“ MOJADIPRO

W —

e x =00

Mk localhost £ 127.0.0.... (a Discord | Friends ﬁ Cnline Courses - U f} chatgpt

Sign in | Sign up |

H londonappbrewery / mi_card_flutter ' Public

<» Code

() lssues 25 Il Pull requests & (® Actions [ Projects

F master ~ P 1branch ) 0tags

TheMuellenator updating gradle wrapper

android updating gradle wrapper
ios updating project for android
lib updating project for android
README.md updating project for android
pubspecyami updating project for android
README.md

L\ Notifications % Fork 1k Y7 Star 401 -

@© Security [|# Insights

Go to file m About

) Starter code for the Mi Card Project from
Local Codespaces

the Complete Flutter Development

53 Clone ® Bootcamp

WiwWw.a )brE'WE'l' L0
HTTPS  GitHub CLI & . Y

[0 Readme
https://github.com/londonappbrewery/mi_card_f ‘f:? 401 st
stars
Use Git or checkout with SVN using the web URL. & 31 watching
% 1.1k forks

&) Open with GitHub Desktop )
Report repository

() Download ZIP



o Android Studio

Projects
Customize
Plugins

Learn Android Studio

F

xylophone_flutter_ master

xylophone-flutter-master

flutterapps_project]

dicee_flutter_master

Mew Project Open New Flutter Project :

Get from Version Control...
[ Virtual Device Manager
¥ Profile or Debug APK
W, SDK Manager

# Import an Android Code Sample



o Android Studio

Projects
Customize
Plugins

Learn Android Studio

New Flutter Project

48 Get from Version Control

4 IJ Repository URL Version control:
https://github.com/londonappbrewery/mi_card_flutter.git

C\Users\Acer\AndroidStudioProjects\mi_card_flutter

Paste URL

O GitHub Enterprise
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¢ Commit

F Pull Requests

Structure

#* Favorites

. A am -
mi_card_flutter |ib = §g main.dart

J— :
|ms| Project =

A mi_card_flutter
> W% idea
> 8 android
> M jos
\ 4 lib
7. main.dart
“55 pubspec.yaml|
2 README.md
Il External Libraries

>, T : =
Y@ Scratches and Consoles

2 README.md ¥e main.dart

Help card_flutte 51t - O

% main.dart - Git: ® L @

& Dart SDK is not configured 0

ebeue 2

AUINO BN &

sUJaNNG &

1008

&
e
=

=

|



4 File Edit View NMavigate

mi_card_flutter = lib & main..
B Project
=
= =
£ v A mi_card_flutter
im » W .idea
— # M android
= > M os
= .
= o libp
< .
@ main.dart
- pubspec.yaml
5 -
a README.rmd
= Il External Libraries
5 7 Y@ Scratches and Consoles
|
=
=
=
]
L 1]
w
=
=
=
i
w

= TODO O Problems

I

Settings

Appearance & Behavior
Keymap

Editor

Plugins

Version Control

Build, Execution, Deployment
Languages & Frameworks

F CfC++

? Schemas and DTDs

Dart

Flutter =

» Kotlin

Markdown

Termnplate Data Languages
Tools
Advanced Settings

Experimental

Languages & Frameworks * Flutter

SDK
Flutter SDK path: C:"-.Erc"-.fluttr:rl

Version:

General

¥ | Report usage information to Google Analytics
Enable verbose logging

Allow files ending with _test.dart to be recognized as tests

App Execution

+| Perform hot relead on save
+| Show structured errors for Flutter framework issues
¥ Include all stack traces

Open Flutter Inspector view on app launch

Editor
v | Show Ul Guides for build methods

¥| Show closing labels in Dart source code

Format code on save

Experiments
Try out features still under development (a restart may be required)

Enable code completion, navigation, etc. for Java / Kotlin (requires restart to do Gradle build)

Enable Hot Ul (an early preview of property editing in the outline view)

Show all possible run configurations for apps or tests, even if a created configuration already exists

¥| Enable embedding DevTools in the Flutter Inspector tool window

—>

OK

Cancel

=]

Apply

1) Event Log

J20EUEs B2AE0 EI"—]

BUIING 131N] &

Jopadsu] BN 9

BB LA JBTINI &

ey o

O
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mi_card_flutter |ib = §g maindart

(@] Project =

W Project
<

<:> Commit

F Pull Requests

Structure

#* Favorites

A mi_card_flutter

> I% idea

> ® android

> M ios

V. lib

ﬂ; main.dart

pubspec.yaml|
% README.md

it External Libraries

5, e - =
“@ Scratches and Consoles

2 README.md

'‘Pub get" has not been run

=4
=
=
a

NOJBIN1 &

4]

10 I 321ny N

1NN &

aiu

ojemnwsy l[']‘j

]
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Mempelajari cara
menggunakan

layout widgets

Container, Column, Row, dan Card
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Container adalah widget yang digunakan IMargm
untuk mengatur tata letak dan penampilan

suatu elemen di dalam tampilan Flutter. ‘ Border
Widget ini memiliki banyak properti yang Padding
memungkinkan pengguna untuk mengubah i h
ukuran, warna, gaya, dan penempatan elemen
di dalamnya.

Content
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Properti yang digunakan di Container

Margin digunakan untuk mengatur ’
jarak antara widget dengan widget O J
lain atau dengan tepi layar.

- Edgelnsets adalah kelas dalam Flutter
.O:) yang digunakan untuk mengatur
jarak (padding) dari tepi widget.

1. Edgelnsets.all(value) mengatur jarak dari
Padding digunakan untuk mengatur = semua sisi widget.
jarak antara isi konten atau isi widget OZ

dan batas widget tersebut. 2. Edgelnsets.only({left, top, right, bottom})

mengatur jarak yang berbeda-beda dari setiap
sisi widget.

3. Edgelnsets.symmetric({vertical, horizontal})
mengatur jarak secara simetris pada sisi vertikal
dan horizontal widget.

Height (tinggi) merujuk pada dimensi -
vertikal dari suatu widget di dalam Oj
Flutter.

4. Edgelnsets.fromLTRB(left, top, right, bottom)
mengatur jarak yang berbeda-beda, dengan
spesifikasi jarak pada setiap sisi yang ingin
diubah.

Width (lebar) merujuk pada dimensi
horizontal dari suatu widget di dalam 04
Flutter.




=8 README.md

—

&?_ main.dart

MyApp Statel

B o h s
"Wwe de
v E 10¢€

dget build(BuildContex

MaterialApp(
home: Scaffoldl(
backgroundColor:

body: SafeAreaf

rt
-
(_+
D
r+t

Colors.

child: Contaliner(

yei1ght:

yidth:

margl Edgeln
padding: Edgel
oL Lors

sets.only(left:
nsets.all(?2 J

e

Emulator

O © 4

CL Pixel 4 AP| 27

0 0 = B

=

)

ez

121
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Multi-child layout widgets adalah widget yang memungkinkan
penempatan lebih dari satu widget di dalamnya. Widget-widget
ini memungkinkan Anda untuk mengatur tata letak dan
tampilan dari beberapa widget secara bersamaan.

Column (Kolom) adalah widget yang mengatur
elemen-elemen secara vertikal, dari atas ke bawah.
Anda dapat menempatkan berbagai widget di
dalam Column secara bertumpuk.

Row (Baris) adalah widget yang mengatur elemen-
elemen secara horizontal, dari kiri ke kanan. Anda
dapat menempatkan berbagai widget di dalam
Row secara berdampingan.

Row

Layout a list of child widgets in the
horizontal direction.

Column

Layout a list of child widgets in the vertica
direction.
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Properti yang digunakan di Column dan Row l‘ MOJADIPRO

children: Properti ini merupakan wajib dan berfungsi untuk
menentukan daftar <widget>[], yang akan ditempatkan.

mainAxisAlignment: Properti ini digunakan untuk mengatur tata
letak vertical pada kolom, dan horizontal pada baris.

crossAxisAlignment: Properti ini digunakan untuk mengatur tata
letak horizontal pada kolom, dan vertical pada baris.

mainAxisSize: Properti ini digunakan untuk mengatur ukuran
utama. Jika sebagai MainAxisSize.max, maka akan memperluas
ukuran. Jika sebagai MainAxisSize.min, maka akan mengambil
ukuran minimum.



=8 README.md ¥e main.dart

“ MOJADIPRO

e Vaelizo

nantainerl

main() {
runApp(MyApp())

—

w
+

A
t
fl
\‘I

1
)
)
W
C

0

build(BuildContext context) {1

MaterialAppl
home: Scaffold(
backagroundColor: Colors

| Contoh
Penggunaan
Kode Pada
Column

]




== README.md g’: main.dart

“ MOJADIPRO

L I ! "lm_,g;b

nantainer]

t build(BuildContext contex

Contoh
S T Penggunaan

Containenr(

Kode Pada Row

F
8
(4]




three’ N Card Widget

Card merujuk pada widget yang digunakan untuk
menampilkan konten dalam bentuk kartu dengan latar
belakang dan bayangan.

Widget Card biasanya digunakan untuk mengatur konten
dalam tata letak. Secara sederhana, sebuah card terdiri dari
beberapa elemen, seperti latar belakang, judul, gambar, teks,

dan sebagainya.

Expiare

Card
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List Tile adalah sebuah widget yang digunakan untuk
menampilkan data dalam bentuk daftar (list) dengan tampilan
yang sudah dirancang secara default. Widget ini digunakan
untuk membuat daftar item yang terstruktur dengan mudah.




Contoh Penggunaan Kode Pada Card & ListTile & Mosnorro

= README.md f main.dart Tﬂa pubspec,yamil

n: EdgeInsets. symmetric(vertical: 1
ListTile(
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Child: untuk menentukan widget yang
akan menjadi konten utama dari card.

Color: untuk menentukan latar belakang
warna card. Dapat berupa objek Color
atau ColorScheme.

Elevation: untuk menentukan tingkat
bayangan atau "elevation" card.

Properti yang digunakan di Card “ et At llidns

Shape: untuk menentukan bentuk card.
Dapat berupa objek ShapeBorder, seperti
RoundedRectangleBorder untuk card
dengan sudut melengkung, atau
BeveledRectangleBorder  untuk  card
dengan sudut miring.

borderOnForeground: untuk
menentukan apakah tepi card akan
ditempatkan di atas atau di bawah
konten card.

Margin: untuk mengatur margin card.
Nilai properti ini dapat berupa objek
Edgelnsets.
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Hot Reload }

class MyHomePage extends StatefulWidget

4 » {.

Launch,?g lib\main.dart on sdk gphone x86 arm in debug mode...

Running Gradle task "assembleDebug’...

v Built build\app\outputs\flutter-apk\app-debug.apk.

Waiting for sdk gphone x86 arm to report its views...

Debug service listening on ws://127.0.0.1:57004/2COnSRMYT -8=/ws
Syncing files to device sdk gphone x86 arm...

Hot reload memungkinkan pengembang
untuk melihat perubahan yang dilakukan
pada kode secara langsung pada aplikasi
yang sedang berjalan.

Perbedaan Hot Reload &
dan Hot Restart

MOJADIPRO

\
J

Hot restart )

class MyHomePage extends StatefulWidget

\main.dart on sdk gphone x86 arm in debug mode...

Launchingegst

Running Gradle task "assembleDebug'...

v Built build\app\ocutputs\flutter-apk\app-debug.apk.

Waiting for sdk gphone x86 arm to report its views...

Debug service listening on ws://127.0.0.1:57004/zC9nSRMYT-8=/ws

Syncing files to device sdk gphone x86 arm...

Hot Restart akan memulai kembali
aplikasi dari awal dengan menonaktifkan
semua status yang ada.

Ini berarti bahwa semua keadaan aplikasi
akan hilang.
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Mempelajari cara
menggunakan file
pubspec.yaml

Memasukkan Asset Image dan Fonts



Memasukkan Asset Image

2mbh File Edit View Navigaste Code Refactor Build Run Toolz VCS Window Help

flutterapps projectl Iib ¥e main.dart Pixel 4 APl 27 (mobile) - %_ main.dart ~
=i #s| Project w D = = = — = README.md ¥y main.dart gz pubspec.yami
=
= ~ £ flutterapps projectl N > s e
oo > .dart_tool e = = -~ T
> = .ides o< Cut Cirl+=X C/C++ Source File
= e en B co Citri+C _/C++ Header File
= > B android [flutterapps project!_ 8 Cop -
E > = build Copy Path/Reference File
= > W fonts O Paste Ctri+V Scratch File Ctrl+ Alt+Shift+Insert
= > B images Find Usages Al+F7 Directory
o > B jos Find in Files... Citrl+=Shift=F Kotlin Script
= =
rehe > hb Replace in Files... Citrl+Shift+ R Kothin Worksheet
> Analyze > Dart File
> Bl macos Refactor ’ Resource Bundie
> P tes - : = . =
By test % Flutter > AX EditoerConfig File
> B=m web ~oLOors.
— Add to Favorites >
> Bl windows
2 .gitignore Reformat Code Ciri=Alt+L
e R e Optimize lmports Cirl+-Al+0O [
= 21T> 1|
a nalysi=_options.yaml Reformat Code with "dart format'...
& 3 4 r A
= . flutterapps_projectlamli
= & pubspec.lock Run "all tests in flutter... Ctri+=Shift=F10 oY _ +T
= am i ~ dImage: AssetImagel
e am pubspec.yaml €. Run 'all tests in flutter...' with Coverage ‘ s S Shane
g -
28 ADN - s i -
“ _ README.md Modify Run Configuration...
= il External Libraries :
= R ~ Cpen In >
= > “gy Scratches and Consoles
Local History > Sy
Lt Rt xtStyle

Klik kanan pada flutter project > New - Directory > Beri nama images
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flutterapps projectl

Project -~ - ' 5! =~ | Downlcads

“~ flutterapps projectl Home

dart_tool

Jddea < = 4 2 J' *
I android [flutterapps project1_android]
= build 3% Quick access

fonts
! B Desktop

<}~ Downloads

IMmageces

==] Documents

=  Pictures

* Template

& OneDrive

yarmli

s _projectl.imd 8 This PC

k 8 3D Objects
Desktop
“5| Documents

< Downloads

* COMPUTERS _ 1

Screenshots

* TEMPLATE PPT I

View

This PC > Downloads

MName

~ Today (1)

,_g_j flutter card.jpg

~ Yesterday (4)

m Scurce_Sans_Pro.zip

m Pacifico.zip
=] OFL.txt

|%| column and row.png

~ Earlier this week (2)

|=]| row-flutter-tutorial.png
|=| snapedit_1684138559823.png

~ Last week (13)
g scaffold.png
ng downlocad-removebg-preview (1).png

|®m| material app.png
\=| flutter windows.jpg

Pilih foto pada document - lalu tarik foto kedalam folder images



. fUB N Memasukkan Asset Image Pada File Pubspec.yaml 8@ 'o-rorPro

Flutter menggunakan file "pubspec.yaml" untuk mengelola dependensi dan asset pada aplikasi.

== File Edit View Navigate Codes Refactor Build Run Tool=s vVCsSs Window Heip
flutterapps projectl aom pubspec.yamt Pixel 4 APl 27 (mobile) ¥ main.dart
= @] Project -~ &S = - =x _ == README.rmd Fe mMmain.dart o= pubspec.yami
g ~ & flutterapps projectl %> Flutter commands =
= > dart_tool - fFflutter : = =
> W .idea
E'__ > R anidroid [flutterapps _project1_android] r _ "1 .8.2
_§ > 5= build
A';: > HEm fonts
? > B images
= > e o
e > B LB flutte
> Bl linux
> B macos ey 1 3 n2.8.0
> 3 test
> BEm web -
> BEmm windowvus 3 3 3 - true
e .gitignore
B4 .metadata
< Saa analysis options.yamil pn i } e . -~ ) ) )
‘E e flutterapps projectl.irmd = = - images/profile-—avata P :l
_—:: B4 pubspec.lock
== "%‘: pubspec.yaml
. == README.md = Pacifico
g Il Externzal Libraries
= > P Scratches and Consoles — =t: fonts/Pacifico-Regular.ttf
e
- — Source Sans Pro
j-i: — fonts/SourcesSansPro-Regular.ttF
- Document 171 flutter: assets: Iterm 11 images/profile-avata...
= TODO © Problems P Version Control ESM terminat = Dart Analysis = togcat «7s Profiler > Run 4 ~App Inspection
Il = daemon started successfully (foday 9:51)

Ketik nama foto yang ada di folder images pada assets > save - klik pub get > run emulator




four Jh

B Google Fonts

A Pacifico Sanience ¥

Categories ~ Language ~

Roboto
Christian Robertson

Whereas recognition
of the inherent dignity

Number of styles ~

Fonts

Type something

Memasukkan Fonts Pada Project Flutter

Icons

40px ~

[] Show only variable fonts @ [[] show only color fonts @

Noto Sans Nandinagari
Google

3 %303

Me (AN A3
ZNeNas MAIY[TTEN
ERIEIE

Knowledge FAQ

—

B B8

About these results @ Sort by: Trending ~

Noto Sans Nag Mundari
Google

U3V O3E3/3 AL
013V83.E 3833
3RO HS 38 K3 LSO
H3dO o 3% 30 8E
W3Va.0l



S\

.' Google Fonts Fonts Icons Knowledge

Google Fonts > Pacifico |& Specimen 3= Type tester 4% Glyphs

Styles

Type here to preview text 48px ~

Regular 400

“9% of)e o@%.ﬁ e

Regular 400 ~

Regular 400 at 48px Reqular 400 at 21px

UWiereas a common

FAQ

t‘ MOJADIPRO

L
: ) 8% Selected family < X

[E) About & license (&, Download family) Review

—a

Pacifico 2

Regular 400 )

Remove all

Use on the web

Remove Regular 400 © To embed a font, copy the code into the
<head> of your html

plllh @ <ink> () @import

<link rel="preconnect" href="http
s://fonts.googleapis.com">

<link rel="preconnect" href="http
s://fonts.gstatic.com" crossorigin
>

<link href="https://fonts.googleap
is.com/css2?family=PacificoSdispla
y=swap" rel="stylesheet">

7100nzM@eW€oan&fmrgwu£,&&nﬁonw n -
exile. Everyone is enfilled in full equality €o a fair and public

(7 APl docs ’ &, Download all

download T




Edit View

s File E
flutterapps_projectl Pixel 4 AP] 27 (mobile)

Project w main.dart = pubspec.yaml

~ 4 flutterapps_project1 = . Fonts

¥ Project

dart_tool
=z : Home Share View
e J1dea
| android [flutterapps_project1_android] i o ™ <« Documents > Fonts > o
.
£ Name

3 Quick access
B Deskt " m Pacifico.zip
eskto ' =
P « © Pacifico-Regular.tif

* Downloads m Scurce_Sans_Pro.zip

=] Documents

o Resource Mana qer

& | Pictures 2
“ COMPUTERS _1

Screenshots

« Buka file zip yang sudah di download

« Ekstract file
« Pindahkan fonts file kedalam fonts folder



Memasukkan Fonts Pada File Pubspec.yami

amb File Edit View Navigate Code Refactor Build Run Toolz VCS Window Helip flutterapps_project bspec.ya
flutterapps _projectl BN fonts Pixel 4 APl 27 (mobile) « % main.dart ~
g~ [@8] Project w g = = = — =8 README.md Fe main.dart i pubspec.yaml
e :
£ ¥ & flutterapps_ project] % Flutter commands Pub get Pub upgrade
==} > dart_tool - Flutter 5
S P= ides Analyze packages to
rg > [ android [flutterapps project1_android] "1 .0.2
= > = build ==
= > B fonts
S > B images
= > I os g
- > lib : flutter
> Bl linux
> B macos T tS: ~2-.89.9
> I test
> BE=m web
> I windows - - true
; ; | ; | ~ Toc
¥% .gitignore
E4 .metadata
=8 -
@ rmnm analysis_options.yaml :
= : e - images/profile-avatar.png
= @ flutterapps projectl.iml - -
= & pubspec.lock
uR iam pubspec.yaml
=B README.md ~ i : Pacificao
% il External Libraries
E > ‘:'?0 Scratches and Consoles 1 ! - fonts/Pacifico-Reqular.ttf
w*
- - Source Sans Pro
= - et: fonts/SourceSansPro-Regular.ttf

Ketik nama fonts pada assets - save




@ A\ Memasukkan Materials Icons “ MOJADIPRO

.' Google Fonts Fonts Icons Knowledge F Q Search < X

Web Android i0s Flutter
Material Icons Category - Q_ Search Material Icons

« Outlined Filled Rounded Sharp Two tone Use in Flutter

Check out the Flutter API docs to customize
icon size and color.

Material Icons « R
= lcon

. . . ) . . l ' Icons.search_outlined,
Material Icons are available in five styles and a range of downloadable sizes and ).
densities. The icons are based on the core Material Design principles and metrics. Design guide Figma file GitHub repo Apache | 4
Flutter ID
search_outlinad

Action

ol
©

Q @ ® 103 v ® @

Search Home Account Circle Settings Done Info Check Circle Delate Visbulity Shopg

Buka Google Fonts - pilih Icons - klik icon yang akan dipakai - Pilih Flutter > Salin kode pada Android Studio



Hasil

main() {

User Interface [t

( ' MyApp StatelessWidget {
{ . @override
LA V4l 3*% Widget build(BuildContext context) {

' MaterialApp(
& home: Scaffold(
backgroundColor: Colors.

body: SafeArea(
Aurora Smmﬁpz Ocr):nd:acimrai(

children: <Widget>[
FLUTTER DEVELOPER CircleAvatar(

radius:
backgroundimage: Assetimage(
)

)
Text(

aurora@gmail.com

style: TextStyle(
fontFamily:
fontSize:
color: Colors.
fontWeight: FontWeight.
)

)
Text(

style: TextStyle(
fontFamily:
fontSize:
color: Colors.
letterSpacing:
fontWeight: FontWeight.

< ® @ )

Card(
color: Colors.

margin: Edgelnsets.symmetric(vertical:

child: ListTile(
leading: Icon(
Icons.
color: Colors.

)
title: Text(

style: TextStyle(
color: Colors.
fontFamily:
fontSize:

)

)
)
Card(
color: Colors.

margin: Edgelnsets.symmetric(vertical:

child: ListTile(
leading: Icon(
Icons.
color: Colors.

)
title: Text(

style: TextStyle(
fontSize:
color: Colors.
fontFamily:

)
)
)
]
)

horizontal:

horizontal:

)

)
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Mempelajari Cara
Memasukkan
App Ilcon



Memasukkan App Icon 84 o-roro

Apo lcon Generator EA App lcon B85 Image Sets &1 Donate <5
|

App icon Generator

Drag or select an app icon image (1024x1024) to generate differant app icon
sizes for all platforms

, ) _ 1I0S and macOS
Click or drag image file ( 1024 x 1024 )

OR

&Y

Generate app icon using Appicons.ai iPhone - 11 different sizes and files

<

iPad - 13 different sizes and files

&

watchOS - 8 different sizes and files

<

macOS - 11 different sizes and files

Android

Android - 4 different sizes and files

File name

Change file name for aill generated Android images

Buka App Icon Generator > Klik image file



@

ag App lcon Generator

EA App Icon

Memasukkan App Icon &84 o roirrO

o
o0

Image Sets

N
e

App icon Generator

Drag or select an app icon image (1024x1024) tc generate different app icon
sizes for all platforms

iOS and macOS

8

iPhone - 11 different sizes and files

<

iPad - 13 different sizes and files

£

watchOS - 8 different sizes and files

macOS - 11 different sizes and files

<

Android

Android - 4 different sizes and files

File name

Change file name for all generated Android images

4. Generate




@ N Memasukkan App Icon &4 o rorro

g Applcons.zip
File Commands Tools Favorites Options Help

AR HbwRO & 49

Add  ExtractTo  Test View Delete Find Wizard Info VirusScan Comment  SFX

m | Applcons.zip - ZIP archive, unpacked size 298,710 bytes

A

Name Size Packed Type Modified CRC32

o e
android File folder 08/06/2023 13:52
Assets.xcassets File folder 08/06/2023 13:52

E]appstore.png 177.936 177.936  PNG File 08/06/2023 13:52 (025EB727

@playstore.png 66.257 66.257 PNG File 08/06/2023 13:52 7231BD28

Buka file zip yang telah di download - Pilih Android - Ekstrak file
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fiy

mipmap-hdpi
mipmap-mdpi
mipmap-xhdpi
mipmap-xxhdpi

mipmap-xxxhdpi

Masukkan folder ke
dalam file res

Memasukkan App Icon

i File Edit View MNavigate Code tefactor Build Run

flutterapps_project1 = android Jp 0 SrC 0 rmain jawa

- T .
Project - oLl =

v ¥4 fluttera pps_project1

I Project

# dart_tool

? i .idea

~ I android [flutterapps_project1_android]
» .gradle
s WE .idea
= app

N cre

o Resource Manager

» debug

= main
java
kotlin
res

drawable

Structure

#* Favorites

build.gradle

gradle

Build “ariants

@ -gitignore




flutterapps projectl

C

=
—
=
[

File

VVYyVVYVYVYVVVY

Edit

flutterapps projectl

Srom

N fc

325 5]

Project

‘.L"ie|'~,

-

dart_tool

adea

android [flutterapps project1_android]

=

lss
1o
] =
hr
m
te

W

.gradle

A

O @A

N\

MNew

r Path/Reference...

Find Usages
Find in Files...
Replace in Files...
Analyze

Refactor

Fiutter

Add to Favorites
Reformat Code
Optimize Imports

Delete...

Open In

Local History
Reload frem Disk
Compare With...

Mark Directory as

Memasukkan App Icon

Run Tool=s V¢

README.md

Flutter commands

P
Ctri= X

Citri+ C

Ctri+V
Alt+F7
Ctri+=Shift=F

Ctrl=Shifi=R

ViV V V

Ctrl+ At L
Ciri=AIt+= 0O

Detlete

kanan pada App - Flutter > Open Android module

Window Helip

<noc device selected

Fe main.dart vaml
ages/protile-avata png
: Pacifico
: fonts/Pacifico-Regula
: Source Sans Pro
fonts/SourcesSansPro-RrRe«

Open Android moduls in Androd Studio

-

z

maimn.dart

-~




Memasukkan App Icon

s app ™

amnd roid SR SrC i = res
=] s Sndroid - = — rx _—
=
& = app
L > manifests
) > Jjawa
= > W java % Kotlin Class/File
E - = P = o C++ Class
a0 —2 . -
= . Add C++ to Module SEs S Es LS
—_— m -
= = cmm /' C++ Header File
e
= Aondroid Resource File
Copy Path/Reference... Android Resource Diirectorny Eerywmere
1 Paste CErle W Sample Data Directory
. . — File
Find Lisages P s = ) )
Eimd im Files... Ctrle Shifte E Scratch File Ctrl+ A+ Shift+ Insert -
. : . Crirectomy: =
Replace in Files... Ctrl+Shift+ R =
. . |mage Asset
Analyze > + Bar
i Wector SAsset -
Refactor -
a ~ : e Fotlin Script L e R T
= Add to Fawvworites > -~ ) ] ere o oOpeern the
= : e Eotlin Worksheet
= me Show In Rescurce Manager Ctrl+Shift+T
= dms  Actineity >
== Reformat Code Ctrl+ a0+ L
i : s Fragrment -
O ptirmize Imports CErl+—Alt+ O
= i Folder >
= s Service -
= Open In -
— L e Ui Component >
A L I Hist v > - :
ocal Historny A utormotive -
o Y>3 Reload from Disk s S PAL >
E Compare With... Cirle D s Wear -
== .
= LoadsUnlocad Modules... . AIDL H
E L N
= Conwert Java File to Kotlin File Ctrl+Al+Shift+ kK &= Widget =
F : . G I >
Conwert to WebP... ororgie
= TODNC £ Problems I version Control ESM Terminal « i Cormpose * Inspection
. Other >

[1 Open fAsset Studio to create an image asset

Pilih Android - Klik kanan pada App = Flutter > Open Android module



Memasukkan App Icon

s Acszet Studio e

Configure Image Asset

lcon Type: Launcher lcons (Adaptive and Legacy) - Preview xhdpi - ¥| Show safe zone Show grid
Mame: ic_launcher

Foreground Layer Background Layer Ciptions

Layer Mame: ic_launcher_foreground

Source Aszzet

Aoc W E - I i C 5 = -
Asset Type: Image Clip Art Text Squircle vounded Square Square
Path: _studiol\ic_launcher_foreground.cml
Scaling
Trirm: Yes (=) No
Resize: . 0] =
A Anicon with the same name already exists and will be pverwritten.

2 Pilih foto yang akan digunakan S Cancel



Memasukkan App Icon

. Asset Studio -

Configure Image Asset

lcon Type: Launcher lcons (Adaptive and Legacy) - Preview xhdpi - #'| Show =afe zone Show grid
Mame: ic_launcher

Foreground Layer Background Layer Ciptions

Layer Marne: ic_launcher_foreground

Source Asset

Asset Type: =) Image Clip Art Text Squircle Rounded Square Square
Path: tterapps_project1hvimagesiflutter.jpg

Scaling
Trirm: Yes (=) Mo

Resize: . 21 %

£ Anicon with the zamdg name already exists and will be overwritten.

Vv

? Atur resize dan klik next

Mext Cancel



Memasukkan App Icon

&8 Asset Studio X tor: CL Pixel 4 API 27

4 D0 « o m A D

Confirm lcon Path (

SomO s

& Search apps

23 MO O

Hhates Mans Lmall Lok Sertings

Res Directory: main Output File

Output Directories: v Bl main File Type: | PNG File

M ic louncher-playstore,png g G
v I res Density: nodpi 8 | 9§ n ‘ ) q’

v B drawable ¢ Cares Shio e Chask

iy ey ‘ Size (dp): | 512x512
M ic launcher background.xml

B inrae - IE B ok o8 ‘
BB mipmap-anydpi-v26 G E19%5 & )
(pmap-anyap : Size (px): | 512x512 .

48 ) i )
M ic louncher_round.xm!

B mipmap-xxxhdpi 0 -~
Ml il EF.p! L4 7

iAm ., ; - . Hlzz Autierap;
il ic_launcher_foreground.png "
4T

B (¢ leuncher round.png

D = .

Bl mipmap-xxhdpi o e
=

m Ul . . W 3

Wl ir lannrher farsarannd nna

M

A Some files (shown in red) will overwrite existing files, ' @

Play Stare 5= WebYiew..  \idget Py

Klik finish = lalu buka di emulator







